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1 Welcome to ALLCapture

 

Welcome to ALLCapture™
 

 

This efficient and easy-to-use program records your onscreen-activity and creates online
demos and movies in a few minutes without the need of programming knowledge.

Create your own demos or movies without any programming knowledge in the following
formats:

· Flash demos
· Executable files
· ASF Windows Media Player

format

· MPEG Format for DVD, SVCD, VCD and without
resolution adaptation.

   

The file sizes of the generated demos and movies are extremely small and can be started very
quickly. 
Therefore the demos and movies can be sent via e-mail and are easy to integrate into your
website.
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2 Introduction to ALLCapture

Introduction

This chapter describes the ALLCapture™ installation, system requirements, features list and the
different output and export formats.

 

· Introduction
· Installation
· Feature List
· Different Formats
· System Requirements

2.1 Introduction

 

Introduction to ALLCapture™
 

 

Record screen activities and create movies for the internet

 

Summarized in 3 steps:

First Step: Recording
With ALLCapture™ you can capture every action on your screen quickly and easily. After
clicking on the record button in the record area ALLCapture records until you end the
recording process in the utility bar.

Second Step: Editing 
After recording your application or onscreen activity you can edit the recorded content. Add
speech bubbles or notes to your slide in order to explain the different steps. You can also
add objects such as an eye-catcher, special effects or images to your project. Even adding
sound or narration is no problem.

Third Step: Publishing 
You can convert the project you created into the format you prefer. ALLCapture™ supports
a multitude of formats which are suitable for the internet or for creating DVD's.
Generating demos is very easy and no programming knowledge is required.
Most of the formats are independent from the operating system and need only standard
Plug-in's which most browsers already contain, such as Adobe's Flash-Plug-In!  

Reasons for ALLCapture™
ALLCapture™ allows your business to function more effectively, helps your employees
become more knowledgeable and enables you to better satisfy your customers.
It also ensures that your on-line support infrastructure will be more flexible and efficient.

In E-Learning, E-Commerce, Training or Sales: Everything comes to a halt without proper
information and support. Online customers demand comprehensive advice, participants in
training programs need descriptive training material, and sales departments require
up-to-date marketing and sales information. 

Your solution is ALLCapture™: Animated demos/movies for any topic can be simply and
quickly compiled and then made available on the internet. A professional software
demonstration can be created in a matter of minutes. By doing so you will be able to market
your products much more effectively and at the same time, increase your sales. A unique
advantage of ALLCapture™ and TurboDemo™, in comparison to previous discussion and
communication channels such as 'Call Centres' or correspondence via e-mail is that costs
are substantially lower. Additionally, thanks to ALLCapture™ and TurboDemo™, your
employees will not only be trained in a cost effective and flexible manner, but also quickly
and efficiently via the Internet or Intranet. 
 

http://www.turbodemo.com
http://www.turbodemo.com
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2.2 Installation

 

ALLCapture™ Installation
 

 

 

To install ALLCapture™ from a CD-ROM, 
 

1. Simply insert the CD-ROM into your drive. 
 

2. The Windows Autorun function will start the ALLCapture™ setup program.  If the CD
does not start automatically, select the Run… option from the taskbar Start Menu and
enter:

D:\CDStart.exe
(replacing D: with your CD-ROM drive letter)

 

3. Follow the instructions of the installation wizard.
 

4. Read the program license conditions carefully.
 

5. Choose the directory where you wish to install ALLCapture™.
 

 

Please follow the instructions of the Setup program displayed on the screen until you receive
the message "The installation has completed".
 

 

 
 

To install ALLCapture™ from a downloaded file, 
 

1. Start the installation file. 
 

2. Read the program licence conditions carefully.
 

3. Choose the directory where you wish to install ALLCapture™.
 

 

Please follow the instructions by the Setup program displayed on the screen until you receive
the message "The installation has completed".
 

 

Introduction / System Requirements / Features 
 

 

2.3 Feature List

 

Feature List

Recording is – easy and quick 
· Capture your desktop by simply pressing a button. 
· The recording window can be configured to meet the required size
· Full screen and multi-screen recording is supported  
· Terminate the recording with only a push of a button
· Mouse cursor can be excluded from recording
· Recording of all overlapping windows and program interactions 
· The PowerPoint Plug-In of the Enterprise Version allows automatic PPT

recording

Simple  and intuitive to work on 
· Uses intelligent  Undo/Redo
· Size of the preview window can be determined by the user  
· It is possible to make the mouse cursor invisible 
· Adding, insertion, deletion and copying of Frames
· Adding Audio, pictures and animated Effects 
· Length of the project can be increased for a more thorough

explanation
· Preview for editing effects in real-time  
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· Adjustable audio quality
· The colour quality and frame rate can be configured by the user

Fast and small Demos
· Excellent compression of Demos through the programs-own

compression technology
· Demos start quickly as a result of streaming technology
· Ideal for sending Demos via email
· Ideal for Integrating Demos into Websites

Special effects
· Animated objects and speech bubbles
· Numerous effects e.g. elastic band effect 
· Character size and other text formats can be individually adjusted
· Various frame transitions allowing more attractive Demos
· Rich Text Editor - Pictures can be added .to speech bubbles
· The .display time of objects can be altered by the user
· Spotlight effect - by shading in the irrelevant parts of the video 
· Zoom effect in the Enterprise Version

Audio, Sound
· Recording + editing  of Audio
· Importing WAV files 
· Compose the complete time line in one go
· Use different sound channels for background music and speech

commentary  
· Insertion and deletion of Audio 
· Audio-Level can be adapted so that it fits the audio in another audio

tracks  

Export Options
· Flash Demo (SWF-Format) 
· ASF-Format for Windows Media Player 
· MPEG for DVD, SVCD, VCD and without resolution adaptation
· executable Demo (EXE-file)  
· Codec user defined, suitable for the Video content
· Increase the Play-Rate 
· Scale the Play-Resolution e.g. for iPod

Additional Options
· Add author information to your Flash Demos
· Fast loading, saving and compiling
· Additional tool: PanelStudio to create your own Flash- navigation bars

2.4 Different Formats

 

Why use different Export Formats?
 

When considering sending a Demo or movie it must be remembered that they are
dependent upon how the end-user views them. This means the end-user may have:

• A different operating system running on his computer than the one you are using
(MS Windows, Mac, Linux etc…)
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• A different internet browser to yours (either no internet browser, Netscape
Navigator, MS-Internet Explorer etc…)

• A long demonstration (1 minute demo, 1 hour movie or even longer)

ALLCaptureä helps you to create Flash, Exe and Windows Media Player files like
MPEG and ASF.

Please see below the advantages (+) and disadvantages (-) of these formats:

Adobe Flash

Flash-Demo (*.SWF)
+ The average size of a 1 Minute / Tutorial is 300 – 550 KB. 
+ Flash Plug-In has a small file size and is quick to download

over the internet.
+ Flash Plug-In is a standard browser plug-in.
+ Audio and Sound are better compressed.
+ Platforms (MS Windows 95 and later, Macintosh, Unix, Pocket

PC, Linux).

- Flash Demos/Tutorials are limited to 16000 Flash frames. 
- An internet browser is required. 
- Demo and movie file size could be larger than the .ASF file

size. 

Executable
Flash File

Exe-Demo/Tutorial 
+ An internet browser is not required. 
+ Platforms (MS Windows 95 or higher).

- Exe-Files can be hard to attach to emails due to firewall
restrictions.

- Exe-Files enlarges the demo by 1000 KB.
- Flash demos or movies as Exe-files are limited to 16000 Flash

frames. 

Windows Media
Player

ASF Windows Media Player Format
+ High Compression
+ Small Files
+ Windows Standard format
+ No duration limitation
+ Can be with Sound
+ Streamable

- Windows Media Player 7 required
- Not Operating System independent
- Limited to 256 colors

MPEG Video File
Format

Export as MPEG Video File Format
+ Automatic generation of files for DVD, VCD and SVCD creation
+ Adjustable bit rate and quality
+ No special Plug-In required
+ Operating System independent

- File size might be to big for Internet usage
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2.5 System Requirements

 

System Requirements
 

 

 

ALLCapture™ User Interface requires at least:
· PC with Microsoft Windows (98 or higher) and 1.2 GHz CPU
· 50 MB of free hard disk space + Space for the projects
· 256 MB RAM (More memory improves performance) 
· Windows Media Player 9 or higher for creating ASF Videos / Movies

End-user requirements for Flash Demos/Tutorials:
· Internet Browser (Microsoft-Internet Explorer, Netscape Navigator, …)
· Macromedia Flash-Plug-In for viewing the demonstrations
· Demos or movies can be viewed on Microsoft Windows (95 or higher), Macintosh,

UNIX, Linux and Pocket PCs

End-user requirements for EXE Demos/Tutorials:
· Operating System Microsoft-Windows (95 or higher)

End-user requirements for ASF Videos/Movies:
· Windows Media Player from Version 7

End-user requirements for MPEG Videos/Movies:
· Capable Player for MPEG Files, like Windows Media Player or Quick Time

Introduction        Installation
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3 ALLCapture Controls

Menus and Buttons to use

This section describes ALLCapture™ menu items and toolbar icons

· File Menu
· Edit Menu
· View Menu
· Movie Menu
· Window Menu
· Tools Menu

· Buttons and Toolbar Icons

3.1 File Menu

File Menu 

· The file menu is used to create, open, close and save
projects files. 

· Over the "Export" option you will get to the Format Selection

· Recent Projects will offer you a list of recent opened
projects

More information to the export formats

3.2 Edit Menu

Edit Menu

· With Edit you can copy, paste or cut objects, as well
as undo or redo actions

· Frames may be copied, not only from within a
Project but also from other Projects. To place
Highlighted Frames in the Clipboard use either Copy
Frames or Cut Frames. Please Note: Frames may
only be Pasted into Projects when the Resolution in
the height and width is the same or higher.

· Deleting objects is done by pressing the DEL key
after you selected the object to delete
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3.3 View Menu

View Menu

Through the View menu you can adjust the display size
of your preview area.

· The scaling of the display size might cause a blurry
view of your project. You can get it to appear
focused when you activate a function over the Tools
menu 

3.4 Movie Menu

Project Menu

· By using Add and Insert Empty Frames you can extend
the duration of your project. Adding Empty Frames just
adds the amount of time to the last frame of the project.
With the Insert Empty Frame option you can  insert frames
that look the same as the one that you have selected at the
moment. 

· In order to make a clear boundary between Chapters, it can
be useful to interpose a colored frame.  The color can then
be masked in and out as required. A standard color can be
defined in menu Tools - Options.

· Record & Add Frames starts the capture mode and adds
the recorded frames to the end of the project, where 
Record & Insert Frames starts the capture mode and
inserts the frames after the actual position of your play
head.

3.5 Window Menu

Window Menu

Over the Window menu you
can choose the appearance
of the program.

· Check or uncheck the
different options to
customize the appearance
of your ALLCapture
workplace!

· The timeline and the
toolbars can be placed user
defined on the desktop.
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Over "Reset Workspace
(Layout)", the objects will
be placed to the original
position. 

3.6 Tools Menu

Tools Menu

      

The Tools menu provides options and
settings that are valid for all projects that you
work on

Settings Tab:

· The "High-quality frames display" option
provides better quality if you resized the
preview area over the Zoom option that
you will find over the View menu

· The color of a frame may be defined with 
Default Frame Color. This option can be
found at Movie - Insert /Add Color Frame.
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Object Creation Tab:

· The "Target Layer" option creates a new
layer in the time line for each object you
add to the project.

· The "Default Time" option lets you decide
the default display duration of the added
objects. You can either decide a default
time for all objects or you can adjust the
time for each object type individually.

Memory Manger Tab:

Choose here if you like use the RAM
optimization feature.
It allows to adjust the maximum amount of
RAM ALLCapture is going to use, before it is
stored in a temporary file on the hard disk.
It is recommended for performance reasons,
to swap to a physically other hard disc drive
than the one your operating system is stored,
if available.

Changes to this feature will become
active after the restart of ALLCapture!

3.7 Time Line

Time Line

- An instruction demo for the Time Line may be found in the ALLCapture
Help File -

Please move your mouse cursor over the colored areas to get a detailed description of the
functionality
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3.8 Icons available in ALLCapture

Icons available in ALLCapture

Description from left to right

· Start a new project
· Open an existing project
· Save the current project
------------------------------------
· Cut selected object
· Copy selected object
· Paste copied/cut object
------------------------------------
· Undo function
· Redo function

· Move Play head to the beginning of the time line
· Move Play head to the previous frame
· Play back time line from Play head position
· Stop Playback at current position
· Move Play head one frame ahead
· Move Play head to the end of the time line
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· Inserts an image to the actual position of the Play head
· Inserts a note to the actual frame
· Inserts a speech bubble to the actual frame
· Inserts an elastic band to the actual frame
------------------------------------
· Inserts sound to the actual frame
------------------------------------
· Inserts a rectangular spotlight area to the actual frame
· Inserts a elliptic spotlight area to the actual frame
· Zoom effect to enlarge screen details.

· Inserts a frame effect to the actual position
· Changes the settings of the selected effect
· Resets the effect settings of  effects with multiple adjustments
· Removes the selected frame effect of the time line

· Moves the beginning of the selected object to the marker position
· Moves the end of the selected object to the marker position

· Moves the position of the Play head to the next object or more specifically, to the different
object types that area available
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4 Capturing

4.1 Capturing Overview

 

Capturing Overview
 

 

Capturing or recording the screen is the first step in the ALLCapture™ process. It is important to
know that the size that you choose for the recording window will become the final size of your 
Demo/Tutorial plus the size of the navigation bar if selected. You can do this manually or use a
preset size. You can also automatically size your capture area to the size of the application you
like to capture or vice versa.

The usage of your memory will increase according to the screen content you record. If you record
an application where the appearance of the GUI (Graphical User Interface) does not change
much, you will have a low memory usage and a very small project size due to the capture logic
ALLCapture uses. If you record a movie or other fast changing surfaces from your screen the
memory usage will increase rapidly. ALLCapture will check the content of the recording area with
the image of the last recorded frame and will store the difference in the memory, depending of
the frame rate you choose, recording a movie would most likely store 15 full size images per
second in the memory when you record with 15 frames per second. When recording applications
less memory is used.
It is strongly recommended to use the Memory Manager feature when recording videos!

4.2 Recording Options

 

Recording Options
 

 

The Recording Options help you to adjust and personalize your recording sessions.

The Dimensions tab lets you choose a
default size for the recording area.
If you do not know how big the recording
area will be before you open the
application, adjust the red rectangle later
on. This is just a quick way of adjusting
the size. See also the "Hot Key" topic!
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The Frame rate tab lets you adjust the
amount of frames that will be captured
per second. In this example 15 frames
per second are being used. In the
brackets to the right of the field you can
find the range of frame rates which are
compatible with your computer. This
range may vary from computer to
computer. If you think your computer is
good enough to capture in a higher frame
rate than ALLCapture recognized at the
start of the program, then please make
sure that you have installed the latest
drivers for your graphic adapter.
By clicking on "Refresh max. frame
rate" button after updating you graphic
card driver, ALLCapture will proof again
the maximum frame rate.

The Sound tab allows you to adjust the
recording attributes of the sound you wish
to record and to select whether or not you
would like to record sound.
As well as being able to record the sound
over the microphone, with ALLCapture
you can even record the sound, such as
phone conferences, directly over the
sound card. Please make sure before you
record sound, that you have chosen the
correct sound card and the correct audio
input device. The device for recording the
sound directly from the sound card is
often named as "Stereo Mix"
Some audio drivers do not support this
option though!
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If you just want to record onscreen activity
without mouse movement, uncheck this
option!

Here you can set a time limit for your
recording session.
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Adjust the delay time of the recording
process in order to position the mouse
correctly and steady its movement.

 

4.3 Capturing Quickstart Guide

To record a software application
 

 

1. Launch the target application you wish to record
2. Launch ALLCapture™
3. Select New Project from the File menu
4. Select a standard capture size, use your own size or adjust the rectangle with the mouse
5. Click on the title bar at the top on the application you wish to capture and the title bar will

become highlighted.
6. Press CTRL-Shift-P and the application will appear in the capture area inside the red

rectangle. 
7. Confirm "Record" within the red rectangle
8. ALLCapture™ will now record the content of the screen in the adjusted frame rate.

9. Click on the  icon in the system tray to end the screenshot session
10. The recorded content will appear in the program for editing or generating an output format

4.4 Hot Keys in capture session!

 

Hot Keys

Control Keys

Application adaptation during recording: 

+  + 

Fit your active application into the red rectangle by pressing CTRL+SHIFT+P.
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Application adaptation during recording: 

+  + 

Adjust or resize the red rectangle to the size of your active application by pressing 
CTRL+SHIFT+R.

Pause the recording session:

+  + 

Use this toggle option if you need to pause your recording session

4.5 Common Problems

Common Problems

It can happen that ALLCapture only records a black area instead of a movie or film. This has
following cause:
To unburden the processor, film contents are decoded directly from the graphic card. This
causes the black recording area during playback in ALLCapture. Windows only makes one
surface available and the operating system does not recognize what takes place under this
surface, therefore ALLCapture can not recognize it. A user can deactivate the hardware
acceleration of the graphic card to capture the contents. With many computers this does not offer
an acceptable playback speed. The hardware acceleration can be found under
"Start/Settings/Control Panel/Display/Settings/Advanced/Trouble Shooting". Slide the control bar
to "No Hardware Acceleration".

More recent answers to Frequently Asked Questions (FAQ) can be found on our support page!

4.6 PowerPoint Plug-In

PowerPoint Plug-In

The PowerPoint Plug-In contained in the Enterprise  Version allows a simple recording of
PowerPoint presentations with a few mouse clicks. The Plug-In works with the versions 2000,
XP, 2003 and 2007. The method of recording is very simple.

1. Start PowerPoint  
2. Load the to be recorded presentation.
3. Choose the desired resolution and if sound is to be recorded. 
4. Run the presentation.
5. ALLCapture opens automatically at the end of the presentation.

The representation of the Plug-Ins is the same for all versions of PowerPoint except with
PowerPoint 2007 which is not displayed in the toolbar but is to be found in Menu under Add-Ins.
Whether the Sound is tapped from the Sound Card or recorded over a microphone during the
presentation itself can be defined in the ALLCapture Standard Settings.

http://www.allcapture.com/eng/support.htm
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5 Editing

5.1 Editing Overview

  

Editing
 

Navigate with the time line to the frame you would like to paste an object onto.
You can add animated objects, photos or images, notes, balloons, spotlight effects, frame
transitions and sound.

All these features are accessible from the tool bar:

Description Notes: Add text via Text Notes and Balloons.

Animated Object: Used to attract the attention of your end-users. 

Add an image: Add your company logo or an image.

Audio Features: Add multiple clips such as sound or narration at the same time.

Timeline options: Select frames, delete frames and set mouse options over your timeline.
 

Spotlight Effects: Use this type of effect to draw the attention of the viewer to the area you wish

Zoom Effect: Use this type of effect to draw the attention of the viewer to the area you wish

Frame Transitions: Make your demos more attractive with frame effects like fading or clock
effect
 

  

5.2 Adding Notes and Balloons

5.2.1 Notes and Balloons

 

Notes & Balloons
 

 

Describe parts of your demo or presentation by using Balloons or Notes. 

Balloons are very useful in explaining a click or an issue found in a particular area.
To add a balloon click on the shown icon.

Notes are text objects with a specified background color. Notes are suitable for
explaining a whole process or a particular step to the end-user.  To insert a note click
on the shown icon.

Define the appearance of your note or balloon

 

5.2.2 Add Text to your Note or Balloon

Add Text to your Note or Balloon

To add or edit text in your note or balloon, simply double click on the specific object.
There is also an option for editing text over the preferences tab in the lower left corner.

The text editor is a WYSIWYG-Rich-Text-Editor where you can integrate images into the text.
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5.2.3 Skins for Notes and Balloons

Notes & Balloons
 

 

Both Notes and Balloons have interchangeable skins that allow you to change the look and feel
of your onscreen notes. They can also be easily resized.

To change the skin of a Note or Balloon:
Click on the Note or Balloon in the preview area.
There are two options to get to the Skin selections:
1. Double click on the note or balloon and click on the "Edit Skin" button
2. Select the note or balloon and choose "Edit Skin" over the Balloon Properties tab in the
lower left corner

To change the skin:
Click on the drop-down menu and scroll through the available skins and select the
one which you would like.
Adjust the position of the pointer for the balloons if needed and click on OK.
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5.3 Animated object

 

Elastic Band 

 

An elastic band draws the attention of a user to the position you want. It encloses a text or area
by using a frame that can be either circular or rectangular. This form of encircling draws the
end-user attention to even the smallest of details. The options for changing the appearance,
such as line thickness, shape and color are available over the object properties tab in the lower
left corner.

5.4 Adding an Image

 

Adding an Image
 

 

Add your logo or an image to your time line. 

To add an image:
 

1. Choose the frame where you would like to start displaying the image
 

2. Click on the "insert picture..." icon in the tool bar 
 

3. The "insert picture..." dialog window will be displayed 
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4. Browse to the location of your image, select it and press on the open button
 

5. The image will be positioned in the preview area
 

6. The image can be resized or moved to another position on the slide
A proportional resizing can be achieved by pressing the SHIFT key 
while dragging the edges of the image 

7. Adjust the display time for the image by draging the ends of the yellow highlighted 
ribbon to the location of your desire.
Alternatively the beginning or the end of the display time can be adjusted over
the marker feature. See therefore the Timeline topic.

Tip: It is possible to define a transparent color for the images over the Properties tab in the
lower left corner

5.5 Adding Narration or Music

Adding Narration or Music

Add Sound or Narration to your Project

Sound Recording option
Adding Sound
Audio Editor

5.5.1 Sound Recording Options

Sound Recording Options

It is possible to record sound while your screen content is being captured as well as to record the
narration afterwards by watching your project. 

Adding sound files to the project is also possible by clicking on the speaker  icon in the tool
bar.
A open dialog will follow where you can choose your wave file. It is only possible to import files
that are in the uncompressed PCM .wav format with 44100Hz 16Bit Stereo. For better handling
you can use a new layer when you add sound to the project.

To add narration later on to the project, because you first added system sound to the project,
click on the down arrow beside the play symbol and choose.

 
By choosing the option Play + Record sound (define audio source), you can alter the audio input
device to change to the record over the microphone.

As well as being able to record the sound over the microphone, with ALLCapture you can also
record the sound, such as phone conferences, directly over the sound card. Please make sure
before you record sound, that you have chosen the correct sound card and the correct audio
input device. The device for recording the sound directly from the sound card is often named as "
Stereo Mix"
Some audio drivers do not support this option though!
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5.5.2 Adding Sound

Adding Sound

To add sound to a project, click on the  icon to browse for a sound file over the open dialog
window. 
The program will add the sound file as an object to your time line where you can place it freely
between the frames if the sound file is shorter than your recording session. You can edit the
content of your sound file by using the Audio Editor. To access the editor, click on the sound file
to edit and double click the appropriate object in the preview area. There you can reduce for
example the loudness of the sound to have it as background music in your project.
The sound file has to be in the uncompressed PCM .wav format with 44100Hz 16Bit Stereo.

5.5.3 Audio Editor

Audio Editor

- An instruction demo for the Audio Editor may be found in the
ALLCapture Help File -

Use the Audio Editor to add silence, adjust volume, add or cut comments, etc.

Please move your mouse over the icons of the Audio Editor to receive more information.
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Sound Highlighting: 

To copy, cut, normalize or hush part of the sound recording it must be first highlighted with your
mouse.  Click in the Editor Window, depressing the left mouse button to highlight the area
desired. Then choose the function which you wish to apply to this area.  When the complete
sound recording is to be highlighted, click in the usual way in the Editor Window and then double
click in the area marked red in the picture.

5.6 Timeline options

Timeline options

The timeline options assist in editing the projects in a faster manner.
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· For disabling or enabling the mouse cursor on a few frames, just select the frames and right
click on the selection to choose the appropriate option. 

· Selecting frames in the timeline is done in four different ways:
- Click and drag in the timeline to select frames
- Set the marker (double click on a frame) and right click in the timeline to choose one of the

three available options, shown in the image on the left.

· Frames may be copied, not only from within a Project but also from other Projects. To place
Highlighted Frames in the Clipboard use either Copy Frames or Cut Frames. Please Note:
Frames may only be Pasted into Projects when the Resolution in the length and breadth is
the same or higher.

· Removing selected frames over "Remove Frames", which is also available in the menu
"Edit".

· Layers of the timeline can be hidden by clicking on the dot below the eye icon, as well as you
can lock/unlock the layers for editing.

5.7 Frame Transitions

Frame Transitions

In ALLCapture you can make your presentations or demos looking more attractive by adding
frame transitions.

There are several effects to choose of:

· Fading
· Random Blocks
· Circle
· Chess
· Clock
· Cross
· 50/50
· Jalousie

· Join 
· Side movement
· Panorama
· Push Frame
· Enlarging Squares
· Rectangle
· Random Stripes
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5.8 Spotlight Effect

Spotlight Effect

The spotlight effect is very helpful if you would like to draw the full attention of your viewer to a
specific part of the project. It is like in the cabaret where just the star is shown in the cone of light
and the rest is kept in the shadow. In ALLCapture you can have two shapes for the spotlight effect:
Round and Rectangular!

· As you see the area around the Spotlight object is greyed
out. The object properties, such as border, border color and
thickness, can be adjusted as usual over the properties tab in
the lower left corner of the program window.

· To change the size of the spotlight area, you can click and
drag the green squares around the object.

· By pressing the SHIFT key while dragging, you will change
the size proportional.

5.9 Zoom Effect

Zoom Function

The zoom is a very practical way to enlarge important details.
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One can, for example demonstrate to a viewer the completion of a Log-In.  Using the above
illustrated tool bar a zoom detail can be placed in the present Playhead position. This detail may
then be carried to the desired position along the Preview Display thereby defining the time limit of
its appearance. With the Objective adjustment in the lower left corner of the Preview Display the
duration of the Zoom-in and out can be defined. In the same way, it’s possible in the Real Time
Preview to control that the time span and detail are correctly adjusted.

5.10 Add Layer

Add Layer

Adding layers may help you for keeping the overview in a project. There is an option over the
tools menu to add a new layer for every object that you add to the project. 

We recommend to add a new layer if there are several objects of the same specification at the
same time visible in the preview area. In this case it is useful to have an extra layer for each
object.

It is also possible to add layer folders to store layers in it. The layers can be placed in the folders
by dragging them over the folder.
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6 Publishing

6.1 Publishing Overview

 

Publishing or generating a Demo or movie

In ALLCapture you can export to various formats like Flash, Flash-EXE, ASF for Windows Media
Player and different MPEG formats.
The Flash and ASF formats are ideal for internet usage and are able to be streamed, which
means that the content of the demo, video or presentation will be preloaded to a specific
percentage and then the content will be displayed while the rest of the content will be downloaded
in the background. The viewer therefore does not have to wait until the content is downloaded
fully. 
The EXE and MPEG formats are usually distributed over CD's, DVD's or as downloads over the
internet. The EXE is for viewing on Windows computers only, while the MPEG format is platform
independent if the appropriate player software is installed (usually pre installed by the operating
system).
There are different presets available for the MPEG output:

MPEG-1
MPEG-2
VCD
S-VCD
DVD

Detailed description:

FLASH / EXE ASF-Windows Media Format MPEG-Format

6.2 Opening an Existing Project

 

Open an existing Demo/Tutorial Project
 

 

To open an existing project, select over the menu "File >> Open Project..." . This activates the
Open Project dialog window. Then select the project (*.tdc) you want to open and click on the
open button. 
The project will open in the software and you can check if it is the correct one by browsing
through the time line.

If you got the right project, you can select the output format over the menu "File >> Export..."

6.3 Flash / EXE Export

Flash / EXE Export

Over the menu "File >> Export..." you find among other formats the options "Export to SWF..."
and "Export to EXE..."
These two formats are both based on the flash format and are restricted to 16000 frames. The
calculation of the used frames is difficult and is not equal to the frames used in the time line.
Therefore we can not give guidelines like 5 minutes will use 8000 frames at a frame rate of 10
frames per second. It always depends on the content to capture, frame rate and objects that you
include to the project.
After choosing the above options you will be asked for the file name and location you wish to
save under!
The next window that opens lets you adjust the options for the flash export:
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· The area "Color Mode" has two options:
    - High: High color mode with 16Bit color
    - Extra High: True color with 32Bit color
· Export Options:

Either export the project as defined in the time line, where you can disable parts of the time
line, or you select the different objects in the custom area below.

Choose here the appearance of your demo, movie or presentation. There are various settings
possible:

· No navigation at all
· Side Panel
· Kiosk Panel

- Side Panel: The Side Panel can be left, right, top or on the bottom of the demo, movie or
presentation, depending on what position is defined in the navigation bar itself. The navigation
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bars can be edited or created with the PanelStudio software.

- Kiosk Panel: The Kiosk Panel can be so far only on the top right position of you presentation
area.The navigation bars can be edited or created with the PanelStudio software.

From the Author settings you can define the text that is displayed over the information button of
your navigation bar.
The Authors URL and the E-Mail area of the information field is click sensitive and guides the
viewer to the website or opens the default e-mail program to send an e-mail!

The "Set information as default" button is saving the entries in the fields for next projects.
This should save the author some time. It is recommended to save only those fields that remain
the same for the most presentations, like Author, Author's URL and Author's E-Mail.

6.4 ASF Export

ASF Export

The ASF Windows Media Player export format creates stunning small files that are streamable
over your website.
This format is viewable with Windows Media Player version 7 and later. To create ASF files you
need at least Windows Media Player 9 installed.
ASF created files have a color depth of 256 colors which is the maximum to create resolution
independent files. Unfortunately there is no higher quality available.
To create ASF files you just have to choose the option "Export to ASF..." over the menu "File >>
Export..." and follow the instructions:

http://www.allcapture.com/eng/products.htm
http://www.allcapture.com/eng/products.htm
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· Video Options:  With Speed it is possible to increase the play back speed and with Size in %
an adjustment of the film resolution possible.  In this way it is recordings can be made
playable on iPod.

· Sound options: Adjust here the sound quality of your ASF files. Higher kbps increases the
quality, and also the file size of the ASF file. 

· Export Options: Either export the project as defined in the time line, where you can disable
parts of the time line, or you select the different objects in the custom area below.

6.5 MPEG Export

MPEG Export

The MPEG Export offers different possibilities to export your time line.

· MPEG 1 Codec: High compression - low quality
· MPEG 2 Codec: Lower compression - good quality
· VCD Format: High compression - low quality (resolution: 352x288)
· SVCD Format: Lower compression - better quality (resolution: 480x576)
· DVD Format: Lower compression - good quality (resolution: 720×576)
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This is the window you will see first:

· MPEG Settings: Choose the video and audio option to adjust the quality for your movie!

· Video Options:  Set the Export Settings. The Standard Setting allows for an adaptation to
DVD-PAL specifications. With Speed it is possible to increase the play back speed and with
Size in % an adjustment of the film resolution possible.  In this way it is recordings can be
made playable on iPod.

· Export Options: Either export the project as defined in the time line, where you can disable
parts of the time line, or you select the different objects in the custom area below.

· Codec: Choose here the codec to suite
your quality needs

· Bitrate: Adjust here the bitrate for the the
movie. It is recommended not to change
the bitrate, as sometimes older standalone
DVD players might not be able to handle
the stream and as a result of this the
movie can not be displayed. The Pick
button brings up a menu to set the
standard bitrate for the different formats.

· Aspect Ratio: Adjust the pixel size for the
different destination usage...

1:1 for PC usage
4:3 for standard TV usage
16:9 for Wide Screen TV usage

2.21:1 Cinema Format (Aspect Ratio)

· Adjust the audio bitrate for the MPEG
movie. The bigger the setting for the kbit/s
the bigger the size for the movie.

6.6 Publish Demo/Tutorial to a Web Site

How can I publish a demo/tutorial to a website?

There are 3 different ways that you can achieve this depending on the following:

· You would like to make your demo display in it's own popup window without internet browser
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navigation buttons 
· You would like the demo to display as a normal internet page 
· You would like to integrate your demo with your current website design 

Displaying The Demo In A Popup Window Using JavaScript

This technique requires the following files after you have exported your project from ALLCapture:
· For an SWF export: demoName.htm, demoName.swf, tdemo.js. 

· For a Java export: demoName.htm, tdemo.js, demoName.bin, skinw.jar,

llp3.jar. 

1. Copy the required files to your web server and ensure that they are all in the same directory as
the web page you are creating/editing. 

2. Copy and paste the following html code into your web page between the <head></head>
tags:
<script language="JavaScript" src="tdemo.js"></script> 

3. When you exported your project, a file called View_demoName.htm was also created. Open
this file in your default web browser. 

4. Under the section titled "Host your Demos on your own server or on a CD-ROM", look for
"Step 2". 

5. You will see at the end of "Step 2" code similar to:
<a href="javascript:openDemo('demoName',123,321);">ALLCapture
Tutorial</a> 

6. Copy and paste that html code into your web page between the <body></body> tags. 

This will create a link on your created/edited page called "ALLCapture Tutorial", that when clicked
will open your demo in a pop up window.

Displaying The Demo As A Normal Internet Page

This technique requires the following files after you have exported your project from ALLCapture:

· For an SWF export: demoName.htm, demoName.swf. 

· For a Java export: demoName.htm, demoName.bin, skinw.jar, llp3.jar. 

1. Copy the required files to your web server and ensure that they are both in the same directory. 

You can now access your demo directly by typing in your web address followed by 
demoName.htm (i.e www.yourdomain.com/demoName.htm).

Integrating Your Demo With Your Current Website Design

This technique requires the following files after you have exported your project from ALLCapture:

· For an SWF export: demoName.htm, demoName.swf. 

· For a Java export: demoName.htm, demoName.bin, skinw.jar, llp3.jar. 

1. Copy the required files to your web server and ensure that it is in the same directory as the
web page you are creating/editing. 

2. Edit demoName.htm in your default web authoring application (or Windows Notepad) so that
you can view the hmtl code/source of the document. 

3. Copy and paste everything between and including the <object></object> tags into your
created/edited web page. 

This coding will embed your demo for you directly into your web page and into your current
design.

As html coding can be quite complicated to someone new to web design, you can find more
information about how to use the <object> and <embed> tags at www.w3schools.com.

http://www.w3schools.com
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7 Ordering and Support

7.1 Ordering Information
 

Ordering Information
 

 

Please visit our home page to view the latest offers. To contact us visit
http://www.balesio.com/eng/contact.htm or send us an email to sales@balesio.com. If you are
interested in purchasing a site license for your company, then please send us an email to 
sales@turbodemo.com with the quantity of desired workstations and we will send you a quote.

Educational prices for schools, universities and colleges are available. Please ask for a quote.

7.2 Technical Support
 

Technical Support
 

 

To confirm that you have the most recent version of ALLCapture™ please view the
ALLCapture™ home page at http://www.allcapture.com in the section Support.
The best way to report problems is to send an email to support@allcapture.com.

When reporting problems, please include the following information:
 

1. Is the problem reproducible?  If so, how?
 

2. What Windows Version are you running (Windows 98, Windows XP, etc.)?
 

3. Which version of ALLCapture™ are you running (see "About ALLCapture™" in the Help
menu)?  Please include the entire "version" line in your problem report.

 

4. If a dialog box with an error message was displayed, please include the full text of the
dialog box, including the text in the title bar.

 

 

http://www.balesio.com/eng/products.htm
http://www.balesio.com/eng/contact.htm
mailto:sales@balesio.com
mailto:sales@turbodemo.com
http://www.allcapture.com
mailto:support@allcapture.com
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8 Contact us

8.1 About us
 

About Us
 

 

balesio GmbH is an innovative software company and market leader in the development of
intelligent application software for the internet. We develop and distribute E-Learning Software,
Presentation Optimizing Software and Internet-Filtering Software Solutions. 
balesio GmbH is represented by distributors in more than 20 countries. Our products are sold in
over 100 countries worldwide. To contact us please visit our home page at 
http://www.balesio.com/Eng/Contact.htm or send us an email to info@balesio.com

8.2 Sales
 

Sales
 

 

The following information is for the English language version of ALLCapture™. There are also
English, German, Spanish, Italian and French language versions of ALLCapture™ available. If
you are looking for a version in one of these languages, please ask one of our sales
representatives to forward your order, feedback or questions to our partner responsible for your
area.
To reach us toll free (for most countries), please visit our web site at 
http://www.balesio.com/Eng/contact.htm or send us an email to sales@balesio.com.

8.3 ALLCapture - Web Site

If you have access to the internet, then please visit us by clicking here.

http://www.balesio.com/Eng/Contact.htm
mailto:info@balesio.com
http://www.balesio.com/Eng/contact.htm
mailto:sales@balesio.com
http://www.balesio.com
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